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1 Introduction 

The GenICam Control Tool (GCT) permits to communicate with cameras which fulfil the GenICam 
standards. The tool allows to set-up a camera, browse and adjust parameters, perform camera 
calibration tasks and visualize and analyze acquired images. GCTv2.2 is the successor product of GCT 
v1.x. It uses the transport layer interface and provides more features. 

The following graphic shows an overview of the connection between the GCT software and the camera. 
The host software uses the CSGenICam SDK to connect to the camera. Regarding the GenIcam GenTL 
standard, the software and your program are interface independent. The only difference is that the 
appropriate transport layer should be used for each interface type. This means if you are using a GigE 
camera, you need a network adapter and the s2i or Kithara transport layer, if you want to use a 
CoaXPress camera you need a frame grabber and the CoaXPress transport layer (delivered from the 
frame grabber vendor).  
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1.1 About Chromasens  

The name of our company, Chromasens, is a combination of 'Chroma' which means color, and 'Sens' 
which stands for sensor technology. 

Chromasens designs, develops, and produces high-quality and user-friendly products:  

• Line scan cameras  

• Camera systems  

• Camera illumination systems 

• Image acquisition systems  

• Image processing solutions 

Today, Chromasens GmbH is experiencing steady growth and is continually penetrating new sales 
markets around the globe. The company's technologies are used, for example, in products and for 
applications such as book and document scanners, sorting systems and inspection systems for quality 
assurance monitoring.  

Customers from all over the world of a wide range of industrial sectors have placed their trust in the 
experience of Chromasens in the field of industrial image processing. 

1.1.1 Contact information 

Chromasens GmbH 
Max-Stromeyer-Str. 116 
78467 Konstanz 
Germany 

Phone:  +49 (0) 7531 / 876-0 
Fax:  +49 (0) 7531 / 876-303 
Email:  info@chromasens.de 
HP: www.chromasens.de  

1.1.2 Support 

Should you ever have problems with the GCT2 that you cannot solve by yourself, please look into this 
manual for additional information, check the troubleshooting chapter 6 contact your local distributor, or 
send us an e-mail. 

Chromasens GmbH 
Max-Stromeyer-Str. 116 
78467 Konstanz 
Germany 

Phone:  +49 (0) 7531 / 876-500 
Fax:  +49 (0) 7531 / 876-303 
Email:  support@chromasens.de 
HP: http://www.chromasens.de/en/support/support/support 

Visit our website at http://www.chromasens.de which features detailed information on our company and 
products. 

  

mailto:info@chromasens.de
http://www.chromasens.de/
mailto:support@chromasens.de
http://www.chromasens.de/en/support/support
http://www.chromasens.de/
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1.2 Conventions used in this manual  

1.2.1 Symbols 

 

 

Warning 

Failure to follow the procedure described in this manual may result in 
damage to the hardware. 

 

 

Caution 

Failure to follow the procedure described in this manual may impair the 
functionality of the device. 

 

 

Indicates a helpful tip. 

 

 

More detailed information can be retrieved online. 
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1.2.2 List of abbreviations 

 

Abbreviation Meaning Explanation 

CXP CoaXPress CoaXPress (CXP) is interface for 
communication between the camera and the 
PC.  
http://www.coaxpress.com/ 

cmd Command prompt Windows Command-line interpreter 

DSNU Dark signal non-
uniformity 

Irregularity in the dark image 

GCT GenICam Control Tool Chromasens Software to communicate with 
cameras which fulfil the GenICam standards. 

GenICam Generic interface to 
cameras 

Generic programming interface for industrial 
cameras administered by the European 
Machine Vision Association 

www.emva.org 

GenApi GenICam module  GenICam module defining the XML Schema 
which is used to describe register maps. 
https://www.emva.org/standards-
technology/genicam/introduction-new/  

GenTL  Generic Transport Layer  Generic Transport Layer interface  

https://www.emva.org/standards-
technology/genicam/introduction-new/  

GigE Gigabit Ethernet  Enables easy connection of industrial cameras 
to by using the Gigabit Ethernet standard. 

PRNU Photo response non-
uniformity 

Difference in sensitivity of the individual pixels 

ROI Region of interest - 

SDK Software development kit  It is a collection of software development tools 
in one installable package 

SFNC Standard Feature Naming 
Convention 

Document of the GenICam standard, which 
provides feature names for common camera 
features. 

TL  Transport Layer   

XML Extensible Markup 
Language 

It is a markup language and file format for 
storing, transmitting, and reconstructing 
arbitrary data.  

  

https://www.emva.org/standards-technology/genicam/introduction-new/
https://www.emva.org/standards-technology/genicam/introduction-new/
https://www.emva.org/standards-technology/genicam/introduction-new/
https://www.emva.org/standards-technology/genicam/introduction-new/
https://en.wikipedia.org/wiki/Markup_language
https://en.wikipedia.org/wiki/File_format
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1.3 Installation of GCT v2.3 

GCT v2.2 does not require the installation or uninstallation of GCT v1.x. Both can exist parallelly on the 
PC. If GCT v2.x was already installed before, an information will indicate you to overwrite the previous 
version of v2.x. 

The transport layer for the GigE interfaces is provided by the GCT installer. For other interfaces, such 
as CoaXPress, the transport layer is provided by the frame grabber vendor. The operation of GCT is 
always the same regardless of the interface. 

After you have downloaded the installation program from our homepage 
https://chromasens.de/en/software , the installation can be started. Therefore, execute the 
GCT_win65_v2.X.X.exe file and following the next steps:  

1. Select your language  

2. The second window shows important information’s about the GCT version 

3. Select the destination where you want to install GCT2 

4. Select the components for installation, you have the following options:  

a. Compact installation, only the mandatory parts are installed (recommended for 
CoaXPress Interface)  

b. Custom installation, you can select the components to install (for GigE interfaces 
without Kithara, you can select s2i Filter driver) 

c. Full installation, install all components (recommended for GigE interface with Kithara) 

 

5. The components are:  

a. The first component is GCT and it is a mandatory part. 

b. The second component (NIC-10GigE-Driver-Files) copies the installer 

program for the driver files of the Intel-supported GigE network adapters (for example 
HPE Ethernet 10Gb 2-port 560SFP+ Adapter) to the PC. If your network adapter meets 
the criterion, you can select this component. It will be installed during the installation.  

c. If the third component (s2i Filter Driver) is selected, the filter driver batch of 

the selected version is copied to the PC. If no filter driver is installed, or an older version 
is installed, you can select this component.  

d. Performance test provides a batch file that permits to test the image data transfer for 
GigE cameras. 

https://chromasens.de/en/software
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e. Kithara Runtime and transport layer files. Select this component for installation only if 
the Kithara Realtime should be applied to the camera(for 10GigE cameras only).  

f. SDK for GenICam Application. If this component is selected, the corresponding 
headers, library files, documents and sample code of SDK are installed. 

6. Select Start Menu Folder  

7. Select Additional Task  

a. Create a desktop shortcut  

b. Create a Quick Launch shortcut  

8. Start the installation  

a. If the NIC-10GigE-Driver-Files filter driver is selected the installer 

automatically setup your environment by running a batch script, for more information 
please refer to chapter 1.3.1.  

b. If Kithara runtime is selected the Kithara configurator starts automatically, please refer 
to the chapter 1.3.2.  

c. If s2i filter driver is selected a batch script (if available, deinstall the old version) install 
the s2i Filter Driver, please follow the instructions in the chapter 1.3.3.  

9. Restart the PC  

1.3.1 Installation of NIC-10GigE-Driver Files 

The NIC-10GigE-Driver Files are installed automatically during the installation. The following 

requirements must be fulfilled to use the NIC-10GigE-Driver: 

• 10-GigE adapter supported by an Intel driver, for example HPE Ethernet 10Gb 2-port 560SFP+. 

• Camera must be connected to the PC  

• Windows 10 64-bit 

The during the GCT installation the command line (cmd) of windows executes the NIC-10GigE-

Driver Files. The executable scan your system to the available network adapter’s which are 

connected to your camera. The window lists all available ethernet adapters and you can configure the 
network adapter by entering a y into the script.  

If you have two adapters the script asks you also for the second one.  

 

After the configuration of the network parameter the scrip can help you to set a static IP Address of the 
network adapter. If you have a default installation you can disagree by entering n into the window. If you 
want to set a static IP Address of your network, you can answer with y  



 

GCT 2.2 | Manual 10 

 
 

1.3.2 Installation of Kithara Transport Layer 

The Kithara transport layer permits to communicate with GigE cameras based on the Kithara software. 
If Kithara should be used, all components shown on the Select Components dialog box must be 
installed. 

After the installation of the Kithara transport layer, the Windows system is configured to suit Kithara, and 
the transport layer file ls_tl_gev_kithara.cti and its library file gevKithara_kernel.dll 

are placed in the default folder C:\Program Files\Chromasens\GCT2\GenTL\Kithara. Also, the 

system environment variable GENICAM_GENTL64_PATH is expanded with the transport layer folder 

from Kithara and from s2i. 

Kithara locates and uses the existing network adapters. This can be configured during the installation 
of GCT in the Kithara configurator dialog. For more information of the Kithara configuration dialog, refer 
to the section 3.3.2. 

After the Kithara transport layer has been installed, you must restart the PC. 

1.3.3 Installation of s2i filter driver and Transport Layer 

The s2i Filter Driver installed automatically during the installation. In addition, a change in 

the BIOS settings is needed before the very first installation of s2i filter driver, as described below.  

 
Disabling Secure Boot 

Secure Boot must be disabled in the BIOS settings. To access the BIOS settings, you must press the 
BIOS key of your PC, while the PC is starting. The BIOS key could be F10, F2, F12, F1, or DEL, 
depending on the manufacturer of the mainboard. Now you can disable the secure boot of your system.  

1.4 System Requirements 

Hardware requirements: 

• TKH Vision GenICam-standard camera 

• Intel Core i7 or higher 

• 16GB RAM or higher 

• Min. PCIe 3.0 lane with min. 8 lanes to install your frame grabber or network card 

Software requirements: 

• Win10 x64 bit operating system 

• Driver for 10-Gigabit Ethernet network interface card or frame grabber software  
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2 GCT v2.2 

This chapter should give you an overview of how to use GCT, it is independent of your hardware.  

2.1 GCT user interface 
The software provides different panel elements, they can be placed, resized, and docked freely within 
GCT window. The GCT user interface starts after successful connection with your camera. The window 
contains four main areas. The Menu bar widget for general access, the Toolbar widget for fast access 
to the most common functions, the image view widget where the image and all relevant information’s 
are displayed and the configuration widget for the camera configuration.  

  

2.1.1 Menu Bar  

The Start Menu offers the following functions:  

• Connect/Disconnect: Opens device discovery widget or disconnect the camera, see 2.2. 

• Start Grabbing: Starts continues image grabbing. 

• Device description: Load and save xml file from the camera. 

• Settings: GCT setting options, see 2.11 

• Exit: Close GCT window. 

The Tools Menu offers the following functions  

• Calibration: Opens a camera calibration dialog, see 2.8. 

• Maintenance Mode: Only for experts. 

• Up/Download: Opens a Up/Download dialog, see 2.7. 

• Register Editor: Only for experts. 

• Kithara Configurator: Opens the Kithara Network Configurator, see 3.3.2. 

The View Menu offers the following functions  

• Default view: Set the GCT view to default.  

• Camera Configurations: Shows the configuration panel in the configuration widget.  

• Message Log: Display the Message Log under the Image view.  

• Refresh Feature Tree: Refreshes the feature tree   

The Help Menu offers the following functions  

• About: General Information’s about GCT  

• Open GCT Manual: Opens the GCT Manual  

• System Information: Generates a System information report  

• Search for GCT Update: Search for GCT updates  
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2.1.2 Toolbar widget 

The Toolbar widget contains the following icons and their functions.  

 

 

The Toolbar widget offers the following button functions:  

• Connect/Disconnect: Opens device discovery widget or disconnect the camera, see 2.2. 

• Reset and reconnect: Resets the camera and reconnect. 

• Start Grabbing: Starts continues image grabbing, see 2.5. 

• Abort Grabbing: Stops the image acquisition.  

• Acquire a single frame: Acquires a single frame.  

• Load image: Load an image from disk, see 2.6. 

• Save image: Save image to disk, see 2.6. 

 

2.1.3 Configuration widget  

The Configuration widget provides two panels, Camera features which is the GenIcam parameter tree 
and the configuration panel which is a graphical representation of the GenIcam parameter tree.  

The following image shows the configuration panel of the configuration widget. The panel contains a tab 
view, from which four main categories can be selected. Each tab contains another tab view with 
subcategories. The content in each sub tab view is scrollable.  

An Info box or tooltip is shown when hovering over a parameter input field or the blue information icon. 
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The Camera Features tab contains the GenIcam parameter tree, the user setup level and an extra panel 
to set up the filter driver.  

 

2.1.4 Image view widget  

The image view widget shows the current image view and additional image and stream relevant 
information’s.  
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Mouse operations on the image 

During or after image acquisition, you can work on the image as follows. 

Function Operation 

Zoom in (factor x 1.05) Mouse wheel forward  

Zoom out (factor * 0.95) Mouse wheel backward 

Move image  Move mouse while holding left mouse button 
pressed 

Reset image to original size  
Click  

Expand image to full display area 
Click  

Read RGB value as 8bit  Move mouse onto the image 

2.1.5 Line plot view  

GCT2 can display a horizontal line plot in the image view widget. To add this feature, add a new tab, 
therefore press the plus on the top. A popup window will be open, please select under the “View Type” 
the “Horizontal Line plot.  

 

 

After this configuration a new window will open as shown in the following figure.  
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2.1.6 Histogram view  

GCT2 can display a histogram of in image content in the image view widget. To add this feature, add a 
new tab, therefore press the plus on the top. A popup window will be open, please select under the 
“View Type” the “Horizontal Line plot.  

 

 

After this configuration a new window will open as shown in the following figure.  
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2.1.7 Arrange / Rearrange widgets  

The software provides different widget elements, they can be placed, resized, and docked freely within 
GCT window. If you are using two monitors you can place, for example, the configuration widget on the 
second screen and the image view widget on the first screen.   

 

If you want to dock the widget again, drag the widget to the area where you want it, it will create a blue 
marked region in the target area. Once the desired position is indicated by the blue area, the widget can 
be dragged.  

 

2.2 Connecting and disconnecting the camera 

To be able to access the camera, GCT needs to create a connection to the camera and to download an 
XML file that specifies the camera interface. 

2.2.1 Connecting 

To connect the camera: 

1. Switch on the camera. Initialization can take up to about 40 seconds. 

2. Start GCT. 

3. On the toolbar click Run device discovery . 

The Discovery dialog box opens and the Discovered Devices list shows information about the 
detected camera. If the camera is not found, wait a few seconds, and then click Start Discovery. 
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1. In the Discovered Devices list, select the camera, and click Open. GCT now downloads the 
file with the camera interface specification, which takes a few seconds. Afterward, the 
Discovery dialog box is closed, and the available camera parameters are shown in the 
configuration widget. 

2. If the Discovered Devices shows no camera, and if you have a GigE camera, please follow 
the instructions of chapter 3.1. 

 

The camera discovery is controlled by several parameters and options, which can be modified if 
necessary: 

Parameter Default value Description 

Timeout 200 msec 

If no camera can be found in the 
specified time, the discovery process 
stops and the dialog shows “No GigE 

Vision device has been 

found.” This value can be adjusted. 

Continuous Disabled 
If you select this check box, the discovery 
process is repeated until you stop it. 

Open Mode Exclusive 
Specifies how the camera should be 
opened. 

GenTL 
Producers 

The producer(.cti) files present 
in the “GENICAM_GENTL64_ 
PATH” folders will be listed and 
selected 

Producer file, which should be used to 
detect and communicate with the 
camera. 

2.2.2 Disconnecting 

After the camera is connected, the Discovery button is replaced by a Disconnect  button. Click 
this button to unlink the connection. If you want to disconnect the camera while it is grabbing images, it 
is recommended to stop the grabbing process completely before you click Disconnect. The 
disconnection progress may take several seconds, due to the cleanup of generated temporary data in 
background. 
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2.2.3 Connecting two cameras with one PC  

The latest GCT2 version does not have support for multiple cameras in one GCT2 instance. To connect 
more than one camera to the PC, you need to open two instances (windows) to connect the camera to 
a PC.  

If you connect two cameras to the PC and open a new instance of GCT2, you can select one camera 
and connect it to the GCT2 instance. Both cameras are visible in the Discovery window. With a second 
GCT2 instance, you can connect the second camera.  

 

2.2.4 Edit Transport Layer  

The Transport Layer (TL) is used to refer to the interface such GigE (Kithara or s2i) or CoaXPress.  
 
During the first discovery process after installation, GCT fetches the paths from the system environment 
variable GENICAM_GENTL64_PATH and searches for .cti files in each of those folders. If cti 

transport layer files are found and can be parsed, the camera can be detected with the corresponding 
transport layer. This may take several minutes during the first discovery process. 
 
If it is required to change the TL you can change it in the Discovery dialog window, as shown in the 
previous chapter. To change the TL press the GenTL Producers button, a Producer List shows the 
available TL, as shown in the image below.  
 

 

To enable or disable a Transport layer, select the certain file, for example 
ls_tL_gev_kithara.cti or GEVTLS2I.cti and click or clear the bock. The discovery 

process is then started using the certain Transport layer. We recommend enabling only one transport 
layer.  
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2.3 Modifying features 

GCT allowed to modify the features in two different ways. On the one hand, the configuration panel 
makes setting functions more convenient, special views show a set of related functions on which you 
can easily change these parameters. On the other hand, the camera feature panel allowed to edit the 
parameter in the XML-Tree  

2.3.1 In the Configuration panel  

The view consists of four main tabs Acquisition Control, Camera Image Calibration, Pixel 
Processing and Special functions. Each tab shows several subtabs. 

The Acquisition Control tab, for example, show five subtabs, which permit to specify many features such 
as image format and trigger settings. Some features also have additional explanation pictures.  
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2.3.2 In the Camera feature panel (XML-Tree)  

On the left side of the GCT window, features and their values are shown in a tree structure organized in 
feature groups. To show the features of a feature group, click on the arrow preceding the group name. 

 

Some features are read-only. Their values are shown in gray color in the feature tree: 

 

Some features cannot be modified during grabbing. Therefore, their values are also shown in gray during 
grabbing. 

How values can be changed, depends on the data type of the feature: 

• For binary features, select or clear the shown check box. 

 

• For numerical values, click on the value. A box and a slider appear that permit to modify the 
value: 

 

• For hexadecimal values, click on the value. A box appears that permits to modify the value: 

 

• For features containing text, a text box appears, at which you can edit the value: 

 

• For the feature type enumeration, a value list appears. Click again on the value to open the list, 
and then click the desired value: 
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• For command features, an Execute button appears: 

 

To execute the function, click Execute. 

2.4 Showing feature details 

Feature details can be displayed in the configuration panel and in the camera feature panel.  

2.4.1 In the Configuration panel  

In the configuration panel, the information is displayed when you move the mouse pointer over the 
parameter input field or the blue information icon.  

 

 

 

2.4.2 In the Camera feature panel  

To show feature details, double-click the feature name or right-click the feature and then click Display 
Feature Detail: 

 

A message box then shows information about type, access, and values: 
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2.5 Grabbing images  

To start grabbing, click Start grabbing  on the toolbar. To stop grabbing, click Stop grabbing  
on the toolbar. 

The grabbing process continues to grab images (frame) from the camera repeatedly. If only a single 

frame should be grabbed, click Acquire a single frame  on the toolbar.  

2.6 Saving/Loading an image 

GCT permits to save the currently acquired image as a BMP or TIFF file, and to load such files. 

To save an acquired image: 

1. If GCT is grabbing images continuously, stop image acquisition. 

2. On the toolbar click Save currently displayed image . 

For a typical RGB8 or Mono8 format, the image can be saved as BMP file. For formats such as Mono10, 
Mono12 or RGB10p32, it can be saved as TIFF file. Each color value of each channel is then scaled 
from 10 or 12 to 16bit in the TIFF file. 

 

To load an image: 

1. On the toolbar, click Load image . 

2. On the file dialog box, click the desired file type in the list, to display the respective images: 

 

3. Select a file, and then click Open. 

Each opened image is displayed in a separate Static Image tab. The images can be viewed with mouse 
actions, as described in section 0. The 16bit TIFF images are currently displayed as 8Bit image, so the 
RGB values are scaled to 0-255. 
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2.7 Up-/Download 

The Up-/Download dialog allows you to Upload files from the PC to the Camera, for example Camera 
Package files, as well as user sets. You can also Download files from the camera to the PC. Supported 
file types and extensions depend on the camera type. 

2.7.1 Uploading files to the camera 

You can restore user settings, calibration files and other file types which are previously downloaded 
from the camera. For installing firmware files (Camera Package file) see section 2.7.3. 

To upload files to the camera (only for Chromasens cameras): 

1. On the Tools menu, click Up-/Download, or use hotkey Ctrl+U. 

 

The Update/Download dialog box opens. 

2. Click Select Update File. A file dialog box opens. 
Select the file you want to upload and then click Open. 
GCT shows a warning message.  

 

3. Select the correct file type for the file you want to upload.  

 

 

4. Click Start Update.  
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GCT2 shows another warning message: 

 

Click Yes to start the upload process or No to cancel the upload. 

 

 

Make sure that the appropriate file type is selected before you proceed. 

5. During upload a progress bar is shown. Wait until the file has been uploaded completely. 

6. Check the text in the Info Box: If the update was successful, it contains a green confirmation 
message “Update is successfully completed”  

 

 

 

If the update was not successful, do not switch off the camera, but try to 
restore the previous state by uploading the correct file for the previously 
selected file type. 
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2.7.2 Downloading files from the camera to the PC 

Firmware files, as well as user sets and other file types, can be downloaded from the camera to the PC 
and saved to a file. 

To download a file from the camera: 

1. Start GCT and connect the camera. 

2. On the Tools menu click Up-/Download. 
The Update/Download dialog box opens. 

3. In the Download list, click the desired file type. 

 

4. Click Download to. A file dialog box opens. 

5. Select a folder, enter a file name and extension, and then click Save. 
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2.7.3 Updating the firmware 

Before you begin: 

1. Download firmware from the Chromasens website or use the firmware file provided by 
Chromasens. 

2. Start GCT and connect the camera. 

3. Note the Device Package Version and/or Device Firmware version of the currently installed 
firmware displayed in the Device Control feature group. 

 
 

To update the camera firmware (only for Chromasens cameras): 

4. On the Tools menu, click Up-/Download, or use hotkey Ctrl+U. 

 

The Update/Download dialog box opens. 

5. Click Select Update File. A file dialog box opens. 
Select the firmware file1 or packages you want to install and then click Open. GCT shows a 
warning message an selects the appropriate file type Firmware in the Update list. 
 

 

6. Click Start Update. 
GCT shows another warning message:  

 
1 For allPIXA SWIR cameras, the firmware file has the following name allPIXASWIR....bin.  
For allPIXA EVO camera the firmware file has the following name allPIXAevo_listfile….ini. 
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Make sure that the appropriate file type is selected before you proceed. 

7. On the appearing warning message, click Yes to start the update process or No to cancel the 
firmware update. 

Depending on the file size, firmware upload may take a few seconds up to several minutes. 

8. During upload a progress bar is shown. Wait until the firmware has been uploaded completely. 

9. Check the text in the Info Box: If the update was successful, it contains a green confirmation 
message “Update is successfully completed”  

 

 

 

If the update was not successful, do not switch off the camera, but try to 
restore the previous state by uploading the correct file for the previously 
selected file type. 

10. If the upload has been completed successfully, close the Update/Download dialog box, 
disconnect the camera, turn it off and after a few seconds turn it on again. 

This is necessary to complete the firmware update! 

11. Reconnect the camera.  

12. Check Device Package Version and Device Firmware version in the Device Control 
feature group to make sure that the camera successfully booted with the new firmware.  
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2.8 Camera calibration  

2.8.1 Creating a black-reference (DSNU) 

1. Switch off illumination and cover the lens with a black or dark piece of cardboard or plastic so 
that there is no light on the sensor. Check that the piece covers the whole lens. 

2. Prepare an image with GCT. Either click the Acquire a single frame  on the toolbar, or 

click Start grabbing , wait until an image is shown and then click Stop grabbing . 

3. On the Tools menu, select Calibration, and then click Generate DSNU Reference. 

 

 The Create DSNU Reference wizard opens. 

4. On the Select image source page, click Use grab view image, and then click Next Step. 

 

5. On the next page, click at the first step (1) Set ImageCalibrationMode…), then at the second 
step, and at last at the third step.  

 

6. If all three steps were reported as successful, click Next Step. The DSNU Reference 
Generator window opens and shows the grabbed image in expected image calibration mode. 
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7. In the Settings for Average Value, enter values for Y-Position and Height to specify the 
area to be used for reference generation, or click Start 2-Click-Selection and click start and 
end position on the image. 

8. To create and save the reference data, click Save DSNU File to Local PC, specify folder and 
file name in the appearing file dialog box, and then click Save and close the wizard. 

9. If you are using the configuration panel to load and activate the DSNU, you can skip the next 
steps. Just, click Upload DSNU data-set and load the xx.dsnu data file. After loading the 
data-set you can activate the DSNU look-up table x. 

 

10. On the Tools menu click Up-/Download, and in the Update/Download dialog box click 
Select Update File. A file dialog box opens. 

11. Select the DSNU file, and then click Open. GCT selects the appropriate file type in the 
Update list. If the file type is correct, confirm the appearing warning message. 

12. Click Start Update, wait until the file has been uploaded completely, and then close the dialog 
box. 

13. To activate DSNU, click the LUT Control feature group, 
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14. Click LUT Selector and click the respective DSNU LUT in the value list: 

 

15. At the LUT Enable feature, select the check box. 
 

To create a dark-reference from an existing image file: 

1. Perform steps 1 to 3 of the above procedure. 

2. On the Select image source page, click Load image from storage, and then click Next 
Step.  

3. Click Choose BMP or TIFF File on the following page and open the desired image file in the 
appearing file dialog box. 

4. Specify a pixel offset, and then click Next Step. 

5. Continue with step 7 of the above procedure. 

 

 

Make sure that the used image has been grabbed with active image calibration 
mode for DSNU, so that all gains and other LUTs are adjusted to fit the 
calibration. 

While Image Calibration Control is active, the temporarily modified features 
are locked and cannot be modified until the feature is set to Off. 

Currently, the input image (regardless of whether acquired directly with the 
grabbing process or loaded from PC) will be converted to 8 bit and then used 
to calculate the DSNU reference. 
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2.8.2 Creating a shading-reference (PRNU) 

1. Check lighting and focusing. 

2. Disable continuous white-control and save the parameters to the camera. 

3. If possible, prepare a moving white target. If you use a stationary target, place the target a bit 
out of focus, to reduce the effect of dust or scratches on the calibration result. 

4. Prepare an image with GCT. Either click the Acquire a single frame  on the toolbar, or 

click Start grabbing ,wait until an image is shown, and then click Stop grabbing . 

5. On the Tools menu, select Flat-Field Correction References, and then click Generate 
PRNU Reference. 

 

The Create PRNU Reference wizard opens. 

6. On the Select image source page, click Use grab view image, and then click Next Step. 

 

7. On the next page, click at the first step (1) Set ImageCalibrationMode…), then at the second 
step, and at last at the third step.  

 

8. If all three steps were reported as successful, click Next Step. The DSNU Reference 
Generator window opens and shows the grabbed image.  
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On the next page, shading parameters must be specified in the PRNU Settings area on the 
right side: 

 

9. Specify the target value for white, and the area that should be used to create the shading data: 

Target Value: Target value of white after the shading reference has been applied. The default 
target is 255, to obtain the full range of the camera (8bit 255). The adjustment of Brightness 
should be performed in the next step with brightness and contrast, which can be found in the 
Analog Control feature group. If necessary, the target value can be set to a smaller value. 

Y-Position, Height: Start and height of the area used to generate shading data. If you specify 
100 and 300 as values, 200 lines starting at line 101 are used. Enter values into the boxes, or 
click Start 2-Click-Selection, and then click on the start and end position of the desired area 
on the image. The specified area is then marked with green color. 

10. If the image has black borders on the left/right side, specify an area for extrapolation: 

For extrapolation on the left side, select the Left check box, for the right side, the Right check 
box. In the Left and Right boxes, enter the start positions of the areas used for extrapolation, 
and in the Width box the width of the areas. 

Start and end position of the areas are marked with red color on the image. 

11. To show the result of the shading correction with the specified parameters, click Test PRNU. 

 

12. To save the shading reference data, click Save PRNU File to Local PC, specify folder and file 
name in the appearing file dialog box, and then click Save and close the wizard. 

13. If you are using the configuration panel to load and activate the PRNU, you can skip the next 
steps and go to step 20. Just, click Upload PRNU data-set and load the xx.prnu data file. 
After loading the data-set you can activate the PRNU look-up table x. 
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14. On the Tools menu click Up-/Download, and in the Update/Download dialog box lick Select 
Update File. A file dialog box opens. 

15. Select the PRNU file, and then click Open. GCT selects the appropriate file type in the Update 

list. If the file type is correct, confirm the appearing warning message. 

16. Click Start Update, wait until the file has been uploaded completely, and then close the dialog 
box. 

17. To activate PRNU, click the LUT Control feature group. 

18. Click LUT Selector and click the respective PRNU LUT in the value list. 

 

19. Click LUT Enable and select the check box. 

20. At the Analog Control feature group, adjust Brightness and Contrast to reach a value of 
about 220-230 in the image (8bit), for example with a brightness value of about 0.9. 

 
To create a shading reference from an existing image file: 

• Perform the steps of the above procedure, but click Load image from storage in step 6, 
click Next Step, click Choose BMP or TIFF File on the following page, and open the 
desired image file in the appearing file dialog box. 

 

 

Make sure that the used image has been grabbed with active image calibration 
mode for PRNU, so that all gains and other LUTs are adjusted to fit the 
calibration. 

While Image Calibration Control is active, the temporarily modified features 
are locked and cannot be modified until the feature is set to Off. 

Currently, the input image (regardless of whether acquired directly with the 
grabbing process or loaded from PC) is converted to 8 bit and then used for 
calculating the PRNU reference 
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2.9 User level 

Each camera contains an XML file specifying the available camera features. When GCT connects to the 
camera, it loads the XML file and shows the features as a tree structure. 

Each feature has a visibility level. While all features are displayed for user level Developer, many 
advanced features are hidden for user level Beginner.  

The User Level is shown above the feature area. To modify the user level, click the displayed User 
Level, and then click the desired level: 

 

2.10 Show message log 

To show the message log, click Message Log on the View menu or click Show message log window 

 in the bottom right corner of the GCT window. A Message Log area is then shown below the image 
area: 

 

To copy messages to the clipboard, mark the messages, right-click on the selected messages, and then 
click Copy on the appearing context menu. 

To copy all present messages, right-click on the Message Log area, click Select All on the appearing 
context menu, and then press Ctrl+C. 

2.11 GCT Settings and configuration files  

2.11.1 GCT Options 

To open the Options dialog box, click Settings on the Start menu. 
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Option name Default value Description 

Wait for image timeout 30000 If the next image is not received after the specified 
time, then it will send a timeout. 

The value can be modified. When GCT is restarted, it 
is set back to 30000. 

Heartbeat timeout 3000 Read the value of GevHeartbeatTimeout from the 
camera (control channel). 

Data Stream Buffer Count 5 Specifies the number of buffers used for each stream. 
The value should be at least 2 or 3. 

Ignore Image Timeout Not selected Can be selected if the acquisition process should 
continue despite timeout error. 

Display Corrupt Image Not selected Can be selected if an image should be displayed 
despite missing data 

Stops If an Error Occurs Not selected  

Draw  All Can be set to display every x frames, or to shut off 
display to reduce CPU usage. 

Enable XML feature 
caching 

Not selected So that the actual value is retrieved directly from the 
camera, instead of from a cached register. 

The options (except Wait for image timeout and Heartbeat timeout) are saved in GCC.ini 

 

2.11.2 GCC.ini file  

The GCC.ini file, which is located under C:\Users\Public\Documents\Chromasens\GCT2, including the 
content of producer path, producer filename, and selected producer for the discovery are already 
adjusted automatically in the file GCC.ini. file. Therefore, if the discovery has already been executed, 

the file GCC.ini could look as follows in the block of [DefaultProducers]. 

 

• ProducerList contains the found cti transport layer files. 

• AdditionalSearchPath contains the additional search paths for cti files, which can be 

added by clicking Add Producer Path. 

• SelectedProducerList contains the cti transport layer files which are selected to be 

applied for the discovery process. 
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3 GigE Interface  

GCT offers two different configurations of the GigE interface Transport Layer to connect and configure 
a TKH vision group camera. The 10 GigE real time solution with the Kithara Transport Layer and the 10 
GigE with the s2i Transport Layer. 

We recommend using the Kithara real-time solution for any real-time application. In some cases, it is 
also possible to use the s2i Transport Layer, but only for single link connections. For dual link 
connections the use of the Kithara Transport Layer is recommended. 

 

 

Packets lost can occur without the Kithara real time kernel solution even with 
large receive buffers in combination with different Hardware components 

 

3.1 Configure the network adapter  
To connect GCT to the camera, you may need to adjust the properties of the network adapter. There 
are basically three methods to configure the IP address and subnet mask of your PC and camera: 

• Use LLA (link-local address) autoconfiguration, this is per default always enabled.  

• Use a DHCP server to configure the network settings of PC and camera, in the default factory 
setting it is enabled. 

• Use manually assigned persistent IP address and subnet masks for camera and network 
adapter, in the default factory setting it is disabled.  

 

In typical installations, the camera is connected directly to the network adapter of the PC with the 
DHCP sever configuration.  

If the camera does not show up in the GCT discovery window, activate the Ignore Subnet check box in 
the Discovery Options window. If the camera now shows up but cannot be connected (Open button is 
disabled), you can set the camera IP address manually. To do this, click the Set Camera IP button. A 
new window will open, as shown below. This window displays your network adapters and their IP 
addresses. Select the network adapter the camera is connected to, and the program will assign an IP 
address to the camera. If this is correct, you can click Save Configuration. Please press the Start 
Detection button again. Now you should be able to connect your camera to GCT2.  

 
To change the IP address configuration of the camera please follow the instructions below.  
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3.1.1 DHCP server configuration  

The DHCP server configuration tries to assign different IP addresses from the Link-Local-Block 
(169.254.x.x) to both the camera and network adapter automatically and set the subnet mask of both 
devices to 255.255.0.0. 

This implies that feature Current IP Configuration Persistent IP is switched off in the camera. This 
feature can be found in the GigE Vision subcategory of the Transport Layer Control feature group 
and is off in delivery condition: 

 

Also, the TCP/IPv4 properties of your network adapter must be configured to obtain the IP address 
automatically as shown below: 

  

 

 

To check the TCP/IPv4 properties of your network adapter: 

1. Open Windows Settings, click Network & Internet, and then Ethernet. 

2. Click Change adapter options. 

3. Right-click the Ethernet adapter that will be used to connect the camera, and then click 
Properties. The Ethernet Properties dialog box is displayed. 

4. On the Networking tab select the Internet Protocol Version 4 item and then click Properties. 
The Internet Protocol Version 4 Properties dialog box is displayed. 

5. Make sure that the Obtain an IP address automatically check box is selected. 
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3.1.2 Persistent IP Address configuration  

The persistent IP address implies that that the feature Current IP Configuration Persistent IP is 
switched on in the camera. This feature can be found in the GigE Vision subcategory of the Transport 
Layer Control feature group and is off in delivery condition. 

 

 

 

To use this configuration the TCP/IPv4 properties of your network adapter must be configured as shown 
in the figure below (configure IP address and subnet mask manually): 

1. In Windows Settings click Network & Internet, and then Ethernet 

2. Click Change adapter options. 

3. Right-click the Ethernet adapter that will be used to connect the camera, and then click 
Properties. The Ethernet Properties dialog box is displayed. 

4. On the Networking tab select the Internet Protocol Version 4 item and then click Properties. The 
Internet Protocol Version 4 Properties dialog box is displayed: 

 

5. Click Use the following IP address. 

6. In the IP address field of the Network adapter specify an address that differs from the IP address 
of the camera only in the last field. When the camera IP address shown in the GCT discovery 
window is 192.168.100.10, you can set the IP address of the network adapter e.g. to 
192.168.100.99. 

7. At Subnet mask enter 255.255.255.0. 

8. Close the properties dialog boxes by clicking OK. 

9. Again click Camera Discovery in GCT. 

Now you should be able to open the camera in GCT. 
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3.2 Tested Network adapters and Transceivers 

The following network adapters are tested with GCT2. The results are shown in the following table.  

Vendor 
Name   

Type  Result  S2i TL Kithara TL 

HPE  HPE Ethernet 10Gb 2-port 
560SFP+ Adapter 

Fully functional  X X 

HPE * HPE Ethernet 10Gb 2-port 
562SFP+ Adapter 

Only with Kithara   X 

Intel * Intel® Ethernet-Converged-
Network-Adapter X710 

Only with Kithara   X 

Myricom  Myricom 2x 10GbE SFP+ low-
profile NIC 

Only with s2i  X  

Myricom Myricom 1x 10GbE SFP+ low-
profile NIC 

Only with s2i X  

Mellanox  NVIDIA Mellanox MCX512A-
ACAT ConnectX®-5 EN 
Network adapter  

Only with s2i 
X  

 

The following transceivers are tested with the allPIXA evo camera and the network adaptes. 

Vendor 
Name  

Type  Comment   Camera 
side 

Network 
adapter 

side  

Finisar FTLX8574D3BCL  

Class 1 21CFR1040:10 
 

X X 

FS  SFP-10GSR-85  X X 

FS Intel E10GSFPSRX 
Compatible 10GBASE-SR 
SFP+ 850nm 300m DOM 
Duplex LC MMF Transceiver 
Module 

Recommended for 
Network adapter 
which are market 
with * 

 X 

 

 

If you are using a the s2i Transport Layer it is required to configure the network 
adapter properly. The HPE Ethernet 10Gb 2-port 560SFP+ Adapter is 
configured during the installation procedure. For another network adapter a 
manual configuration is required, see chapter 3.4.4.  

* Some manufacturers encode their cards. Those cards can only be used with 
the appropriate transceivers. 
Example: intel X710 chipsets only work with intel or intel configured 
transceivers 
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3.3 10 GigE interface with Kithara real time solution  

Kithara Software was developed by the company Kithara. The real-time solution of Kithara is a 
comprehensive system library, which combines industrial automation, machine vision, hardware drivers 
and communication seamlessly, while being completely flexible and modular at the same time. In nearly 
any conceivable industrial application. Kithara real-time can provide fast image capturing with the GigE 
Vision standard and can achieve a high performance. Running Kithara real-time requires dedicated CPU 
cores. On those reserved cores, the real-time system is booted, which, from here on, functions just like 
a separate RTOS while Windows retains its full operability on the remaining CPU cores. From this point 
on, Windows and the real-time system run simultaneously and parallel to each other on the same 
computer, without one restricting the other. 

3.3.1 Licensing 

A valid software license including a USB dongle is required to use the Kithara transport layer. Please 
contact Chromasens about information on licensing options.  

 

https://www.chromasens.de/en/distribution/contact  

3.3.2 Kithara Configurator 

During the full installation of GCT, the Kithara Configurator is started automatically. Alternatively, you 
can start it later by clicking Kithara Configurator on the Tools menu of GCT. 

To configure the system with the Kithara Configurator: 

1. Plug in the license USB dongle before using the Kithara Transport Layer. 

2. On the Introduction page, click Next. 

On this page the current internet adapters are listed. Adapters that are connected and in 
use are shown as active; adapters that are not connected or at which the device is switched 
off are shown as inactive. 

3. If Kithara is going to be used with a single cable connection, select the corresponding adapter 
port in the adapter list, click Create Single Link Connection, and then click Next. 

 

https://www.chromasens.de/en/distribution/contact
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4. If Kithara is going to be used with two cables (which connect two dual ports of the same 
network adapter), select the two adapter ports in the adapter list, click Dual Link, and then 
click Next. 

If you want to operate more than two single link cameras with one Kithara license, you have to assign 
one additional CPU core to Kithara for each additional camera. E.g. if you want to use four cameras 
and have Kithara already installed (two cores are already preserved for Kithara) You have to add two 
more CPU cores to Kithara. For details of implementation please contact Chromasens support. 

Pay attention: Make sure that your PC offers enough 8lane PCIe 3.1 slots to cope with the data 
transmission of two cameras! For more information see the manual of our PC (Mainboard) 

The configurator adds a file kithara_config.txt to the folder 

C:\Users\Public\Documents\Chromasens\GCT2, which contains the hardware IDs of the 

network adapters on which Kithara will be executed. Without this file, the Kithara transport layer is not 
able to detect the devices in GCT. The Kithara Configurator also adds the dedicated CPU cores for 
Kithara (refer to section 3.3.8) and disables Hyper-Threading (refer to section 3.3.7). The Kithara 
Configurator will prompt the system to reboot to update the changes. 

 

 

The Kithara configuration can currently be executed once before the first use of 
Kithara. After Kithara has been used at least once, the configured adapter 
port(s) are dedicated to Kithara and cannot be used from within Windows 
unless the driver is set back manually. In the Windows Device Manager the 
network adapters can be found in the Kithara System Device section. If the 
cable connection for Kithara is changed, it is required to reset the network 
adapter driver to the original Windows network adapter driver (so that the 
device can be found under Windows) and rerun the Kithara Configurator. 

 

3.3.3 Camera connection with Kithara Transport Layer 

After the full installation the camera connection is working with the Kithara Transport Layer. To connect 
the camera, proceed as follows:  

1. Make sure that the license USB dongle is plugged in before using the Kithara Transport Layer. 

2. Make sure that you configure the Kithara Transport Layer properly. The configuration is done 
automatically during the installation of GCT. For more information, see sections 3.3.2. 

3. When you start GCT, the first step is to detect the camera. The Kithara TL can be used like 
any other producer.  
 

 

If the Kithara transport layer file ls_tl_gev_kithara.cti has been 

selected in the Select TL Producer dialog box, and the file 
kithara_config.txt in the folder 

C:\Users\Public\Documents\Chromasens\GCT2 has been 

configured, a blue Kithara window may appear for some seconds during the 
first camera discovery with Kithara TL 
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3.3.4 Resetting network adapter driver back to Windows driver 

After discovering the camera with the Kithara transport layer file, the corresponding network adapter 
connections are assigned to the Kithara driver and can no longer be found in the list of normal network 
adapters in the Windows Device Manager.  

As shown in the following screenshot of the Windows Device Manager, the two entries of the dual port 
HP network adapter (HPE Ethernet 10Gb 2-port 560SFP) are not available in the Network adapters 
list. Instead, they are present in the Kithara System Devices list with the name Kithara RealTime -PCI 
Intel 10 GbE Network Controller. 

 

 

 

It is not an issue if the camera is always only to be used with the Kithara transport layer. But if the 
adapter should be used outside the Kithara application, the adapter driver must be set back to the 
original Windows driver, so that it can again be available for other windows applications. 

To reset a Kithara RealTime PCI network controller: 

1. Run the Kithara Configuration 3.3.2 and remove the single or dual link connection from the 
list. Therefore, select the connection and press the Remove connection button.  

2. On the Windows Settings window, click Network & Internet and on the next window click 
Change adapter options. 

3. Right-click one of the Kithara RealTime PCI network controllers, and then click Properties. 

4. Click Configure and on the next dialog box click the Drivers tab. 

5. Click Update Driver. 

6. Click Search driver on my PC and then click Select available drivers from a list of my PC. 

7. Select the suitable adapter driver and then click Continue. 

8. After the reset the Network adapter configuration must change by following the steps in 
chapter 3.4.3 or 3.4.4. 

9. After these steps, the adapter (HPE Ethernet 10Gb 2-port 560SFP in this example) is 
removed from Kithara System Devices, and is again available in the Network adapters list: 
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3.3.5 Performance Test with Kithara 

When the Kithara transport layer is installed, a separate performance program is copied to the folder: 
C:\Users\Public\Documents\Chromasens\GCT2\performanceTest\withKithara. 

To run the performance test with Kithara, a Kithara-specific dongle representing the license must be 
plugged in an USB slot. If this dongle has not been delivered yet by Chromasens, contact sales or 
support. 

The performance test program with Kithara is independent of GCT. It can be started directly without any 
configuring. 

The program has the following parameters: 

• start_line_time:  Start value of camera acquisition line time in microseconds. 

• stop_line_time:  End value of camera acquisition line time in microseconds. 

• line_time_step_width: Time step from start_line_time to stop_line_time in 
    microseconds. 

• iteration_time:  Test duration of each line time in seconds (integer). 

• width:   Image width in pixels. If this parameter is not set, the current 
    width is used. 

• height:   Image height in pixels. If this parameter is not set, the current 
    height is used. 

• rgb10:   Format flag. If 0, the format RGB8 (each pixel has 24 bit) is 
    used for image acquisition. If 1, RGB10p32 (each pixel has 
    32 bits) is used instead. In case of RGB10p32, the camera 
    transfers 33.3% more image data. 

Example of a command line: 

PerformanceTest.exe start_line_time 30.0 stop_line_time 40.0 

line_time_step_width 5.0 iteration_time 60 rgb10 1 

This means, the camera uses RGB10p32 as image format, starts with an acquisition line time of 30.0 
microseconds (us), stops after 40.0us, and the step is 5.0us. With each acquisition line time, the test of 
each different line time will take 60 seconds. The running program can be stopped by pressing any key. 

When the performance program is started, Kithara searches all available ports of the PC. If the camera 
is connected with a single cable, the corresponding index must be entered as shown below. If the 
camera is connected to a dual port network adapter with two GigE-cables, the indices of both ports must 
be entered.  

In the example shown below, a dual port network adapter occupies two ports with the same identifier 
PCI\VEN_8086&DEV_10FB&SUBSYS_17D3103C&REV_01. The ports differ from each other only 

by the ending #01 or #02: 

 

So, if a camera is connected to both ports of this network adapter, then index 1 and 2 must be both 
selected to start acquisition. 
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3.3.6 Kithara_config.txt file  

The kithara_config.txt contains the hardware ID of the network adapters and the configuration 

whether it is a single or dual connection. The file is created executing the Kithara Configurator 3.3.2. 
The file is in the folder C:\Users\Public\Documents\Chromasens\GCT2  

If only a single link is used with Kithara, this file contains the hardware ID of the chosen connection as 
single entry: 

 

If dual link is used with Kithara, this file contains two items from the dual connections: 

 

3.3.7 Disabling hyperthreading 

If the processor supports hyperthreading, do not split a physical core between Windows and Kithara to 
maximize runtime efficiency. If the Kithara transport layer is installed during installation of GCT, the two 
following commands are executed during the installation in background using Powershell: 

bcdedit /set hypervisorlaunchtype off 

Disable-WindowsOptionalFeature -Online -FeatureName Microsoft-Hyper-V-All -NoRestart 

3.3.8 Reserve dedicated CPU cores for Kithara 

If the Kithara transport layer is installed during the GCT installation, two cores of the multicore processor 
are automatically reserved for the Kithara real-time applications, while Windows and the remaining 
programs are restricted to the remaining processor cores.If GCT is uninstalled, the reserved processor 
cores are freed automatically. 

 

https://kithara.com/en/docs/krts:tutorial:setupdedicated. 

https://kithara.com/en/docs/krts:tutorial:setupdedicated
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3.4 10 GigE Connection with s2i Transport Layer  

The s2i transport layer does not require an additional license dongle.  

3.4.1 Filter driver  

The s2i transport layer offers the usage of a filter driver. A filter driver is used to get the UDP-image-
data packets before the operating system is accessing them. This leads to a drastically improved error 
rate and decreases the number of lost packets drastically. To configure the filter driver, go to the 
Configuration widget and select the Camera Features tab, here you can check and uncheck the 
filter driver.  

 

3.4.2 Manual installation and deinstallation of s2i Filter Driver 

If the component s2i Filter Driver is selected during installation, it is installed automatically from the 
installer. If you want to change the filter driver manually afterwards, please follow the instructions below. 

To be able to apply the s2i filter driver in GCT, at least version 2.4.1 of the filter driver must be installed 
(V2.7.0 is recommended). The batch files for installation and removal can be found in the folder: 
C:\Program Files\Chromasens\GCT2\drivers\s2iFilterDriver. 

 

To install the s2i filter driver: 

1. Run the batch file InstallFilterDriver.bat as administrator. 

2. Reboot the PC. 

For more information, refer to the instruction HowTo_Install_Driver_Windows.pdf in the 

folder C:\Program Files\Chromasens\GCT2\drivers\s2iFilterDriver. 

 

To remove an older version of the s2i filter driver: 

3. Run the batch file UninstallFilterDriver.bat. 

4. Reboot the PC. 

5. In the folder C:\windows\system32\drivers remove the file s2iGEVFilter.sys 

if it is still present. 

3.4.3 Setup for adapters supported by Intel driver under Windows 10 64-bit 

This setup is only needed if you do not have selected the NIC-10GigE-Driver Files during the 

installation procedure If the following conditions are fulfilled, the setup can be performed using a 
Powershell script as described below: 

• 10-GigE adapter supported by an Intel driver, for example HPE Ethernet 10Gb 2-port 560SFP+. 

• Camera must be connected to the PC  

• Windows 10 64-bit 

Otherwise, the setup of the network adapter must be performed as described in section 3.4.4. 
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To setup the adapter using the Powershell script: 

1. Install the intel driver for 10-GigE network adapter manually. 

By default, the network adapter driver can be found in the folder 
C:\Program Files\Chromasens\GCT2\drivers\NIC-10GigE\Win10  

if the option NIC-10GigE-Driver Files was checked during GCT installation. The newest 
driver version can be also downloaded from the Intel website under 
https://downloadcenter.intel.com/de/download/25016/Intel-Network-Adapter-Driver-for-
Windows-10. 

2. Double-click the executable network adapter driver to run its installation. 

3. Start Windows PowerShell as administrator. Windows 10 comes with a Cortana search box in 
the taskbar. Just type powershell in the search box. Right-click on Windows PowerShell 

on the results, select Run as administrator, and confirm with Yes. Then type the following 
row in the PowerShell console window to run the PowerShell script 
 
C:\Users\Public\Documents\Chromasens\GCT2\config10GigE.ps1 

4. According to displayed hint, enter y or n, to setup for each adapter connection. The 10-GigE 
adapter connections will be listed. If only a single connection will be used, then chose this 
connection to perform the setup. 

 

5. After the configuration of the network parameter the scrip can help you to set a static IP 
Address of the network adapter. If you have a default installation you can disagree by entering 
n into the window. If you want to set a static IP Address of your network, you can answer with 
y. 

 

 

  

https://downloadcenter.intel.com/de/download/25016/Intel-Network-Adapter-Driver-for-Windows-10
https://downloadcenter.intel.com/de/download/25016/Intel-Network-Adapter-Driver-for-Windows-10
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3.4.4 Setup for adapters not supported by Intel driver or under Win 7 64-bit 

In contrast to section 3.4.3, this section is now oriented to the network adapters, which are not supported 
by Intel, or the operating system is Win7 x64. Setup depends on the adapter manufacturer. Normally 
you need to install the driver of your own 10-GigE adapter first, then set parameters with proper values 
manually. The GUI of setup can vary from adapter to adapter. The following setup is just an example. 
 

To setup the adapter manually: 

1. On the Windows Start menu, click Settings. 

2. In the Settings window, click Network & Internet, and then click Change adapter options. 
The Network Connections window opens. 

3. Right-click one ethernet connection of the Gigabit Ethernet network card, and then click 
Properties. The Properties dialog box opens.  

4. Click Configure, and then click the Advanced tab. The available parameters may vary and 
are depending on the adapter. 

5. Set proper values for the relevant parameters: 

Attribute name (English) Attribute name (German)  Value 

Interrupt Moderation Interrupt-Drosselung Enabled 

Jumbo packet Jumbo Packet 9014 Byte 

Large-Send-Offload 
V2(IPv4) 

Large-Send-Offload V2(IPv4) Enabled 

Large-Send-Offload 
V2(IPv6) 

Large-Send-Offload V2(IPv6) Enabled 

Direct Cache Access Direct Cache Access Enabled 

Receive Buffers Empfangsbuffer Max (e.g. 4096) 

Flow control  Flusssteuerung Disabled 

Interrupt Moderation Rate Interrupt-Drosselungsrate Adaptive 

Low Latency Interrupts Low Latency Interrupts(LLIs) Disabled 

Transmit Buffers Übertragungspuffer Max (e.g.16384) 

Rx and Tx from Offloading 
Options 

Rx und Tx von Offload-Optionen Enabled 

Receive Side Scaling RSS (Empfangsseitige Skalierung) Enabled 

RSS queues RSS-Warteschlangen 2 

Log Link State Event Verbindungsereignis protokollieren disabled 

6. In the Network Connections window, for both 10-GigE network adapter connections, right-click 
it, click Properties, click the Network tab, and only enable s2i GigE-Vision Filter Driver and 
Internet protocol version 4 (TCP/IPv4). 
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4 CoaXPress interface 

GCT2 supports the CoaXPress (CXP) interface as well. To use the CoaXPess interface with GCT2, 
please follow the installation instructions above for GCT2. For the driver of the CoaXPress frame grabber 
as well as the transport layer, please follow the instructions of the grabbers manufacturer.  

Note: The power over CXP option is set in the frame grabber configuration. 

4.1 Tested frame grabbers  

The following CXP frame grabbers are tested with GCT2. The results are shown in the following table.  

Manufacturer  Type  Result  Comment  

Euresys CoaxLink Quad CXP12 Fully functional   

Matrox  Matrox Rapixo CXP Quad Known Bugs  Updating the image width 
causes a GCT crash, a restart 
of GCT is necessary 

No support of RGBa8 images  

Basler  CXP-12 Interface Card 4C Fully functional  

Bitflow  Fully functional   

 

4.2 Connection two cameras with one Frame grabber 
If you want to use two cameras with one frame grabber, you may have to configure the frame grabber 
(see frame grabber manual). Once it is configured correctly, you can connect the cameras as 
described in chapter 2.2.3. 

4.3 Configure CXP version  
The data transfer rate depends on the configured CXP standard version. This option can be set with 
the parameter "Cxp version used" as shown in the following figure. We recommend using the version 
CSP_Version_2_0. The CSP standard 1.0 supports a data rate of 6.26 Gbps, the CXP standard 2.0 
supports a data rate of 12.5 Gbps per cxp cable.  

 

 

4.4 Link configuration  

The link configuration defines how many CoaXPress cables are connected to the camera and the data 
transfer rate. The number of connected CoaXPress cables are assigned with the Xn. For example, a X2 
means that two cables are connected to the camera. The data transfer rate per connected cable is 
defined with the first number in the selectable cxp link configuration CXPt_Xn.  



 

GCT 2.2 | Manual 49 

 

The following table shows the link configuration parameters and there corresponding data rate (for CXP 
Version 2.0). The data rate refers to one connected CXP cable X1. The data rate increases with 
additional connected CXP cable. CXP12_X2, for example, has a data rate of 25 Gbps. 

Link configuration  Data rate per link Xn in Gbps 

CXP1_Xn 1.25 

CXP2_Xn 2.50 

CXP3_Xn 3.125 

CXP5_Xn 5.00 

CXP6_Xn 6.25 

CXP10_Xn 10.00 

CXP12_Xn 12.5 
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5 SDK – CSGenICam 

The Chromasens GenICam SDK (CSGenICam SDK) is an optional part of the GCT software package. 
It can be seen as an abstraction layer above the GenICam GenApi and GenTL interfaces, as shown in 
graphic below: 

 

 

 

It permits to write applications against the CSGenICam interface. The CSGenICam interface provides a 
set of convenience functions and additional functionalities specific to Chromasens cameras. As an 
example, it adds functions that permit to perform file transfers from/to the device. It has a slightly 
simplified interface when compared to the more abstract GenApi and GenTL producer libraries. 

For more information on how to use the SDK, including a complete API reference, refer to the SDK 
documentation. 

 

https://chromasens.de/de/software  

 

https://chromasens.de/de/software
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6 Troubleshooting 

6.1 Troubleshooting with GigE Interface  

6.1.1 No camera if found during discovery  

In the case you cannot find a camera in the device discovery, you may have to check you IP address 
configuration of you network adapters. Therefore, please follow the descriptions in chapter 3.1. 

 

 

6.2 Troubleshooting Kithara Transport Layer 

6.2.1 No camera is found during discovery 

Make sure that the license USB dongle is plugged in. Also make sure to configure the Kithara transport 
layer before use by following the steps described in the section 2.2.4. 

6.2.2 Discovery takes a long time to finish 

It may happen that the discovery takes a long time to finish its process without detecting the camera, 
even though the system is configured properly. In such cases, restart the system and try again. If the 
Kithara Transport layer is used to detect the camera, run the Kithara Configurator application again to 
set all the Kithara-related parameters correctly. 

6.3 Possible reasons for GEV_TIMEOUT_ERROR 

Sometimes during image grabbing, there comes no image from the camera, and the message log shows 
GEV_TIMEOUT_ERROR in the bottom area. This can be caused by following reasons. 

6.3.1 Trigger mode not set correctly 

Trigger source: If there is no explicit trigger available and the camera should run in “free-running” mode, 
but the value of trigger source does not correspond to this mode, then GCT will return 
“GEV_TIMEOUT_ERROR” and cannot grab images. 

 
 

6.3.2 Filter driver not installed properly (only for 10GiGE without Kithara) 

GCT can use the filter driver developed by s2i. If the filter driver should be used for the grabbing process, 
it must be installed and enabled correctly beforehand in the adapter settings. 
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To check the adapter settings, go to Start menu -> Settings -> Network & Internet. On the Settings 
window, click Change adapter options. A new dialog box opens with a list of network connections. 
Right-click the corresponding GigE Ethernet connection for the camera and then click choose 
Properties. If a teaming group is used, then right-click the teaming group and choose its attributes. 
Ensure that s2i GigE-Vision Filter Driver is selected and that the version is correct. 

 

6.3.3 “Secure Boot” not disabled in BIOS settings (only for 10GiGEwithout 
Kithara) 

If the filter driver is installed properly and can also be detected, but 
“GEV_STATUS_DRIVER_READ_ERROR” appears during grabbing, it could be due to Secure Boot in 
the BIOS settings. In this case refer to section 3.4.2. 

6.3.4 Firewall is not completely allowed for GCT 

Data transfer between camera and PC requires firewall allowance. Normally, the firewall rule is 
exclusively allowed for GCT automatically after installation. 

To verify the firewall rule: 

1. On the Window Start menu, click Settings-> Update & Security -> Windows Security -> 
Firewall & network protection. 

2. Click Advanced settings and highlight Inbound Rules in the left panel. 

3. Find the rule name GCT2_x64, open its properties, and ensure that the firewall rule is allowed 
for all types: domain, private, and public. 

 

6.3.5 Reboot 

If GEV_TIMEOUT_ERROR occurs only if the filter driver is activated, you can reboot your PC to resolve 
unknown conflicts in the hardware. 
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